Manual Part Number
150138
Second Edition, November 2020
Printed in China.

Copyright
© Agilent Technologies, Inc. 2020
No part of this manual may be reproduced in any form or by any means (including electronic storage and retrieval or translation into a foreign language) without prior agreement and written consent from Agilent Technologies, Inc. as governed by United States and international copyright laws.

Agilent Technologies, Inc.
6779 Mesa Ridge Road, Suite 100,
San Diego, CA 92121, USA

Operating Temperature
Operating Temperature: 15-32°C
Storage Temperature: 1-40°C

Warranty
The material contained in this document is provided "as is," and is subject to being changed, without notice, in future editions. Further, to the maximum extent permitted by applicable law, Agilent disclaims all warranties, either express or implied, with regard to this manual and any information contained herein, including but not limited to the implied warranties of merchantability and fitness for a particular purpose. Agilent shall not be liable for errors or for incidental or consequential damages in connection with the furnishing, use, or performance of this document or of any information contained herein. Should Agilent and the user have a separate written agreement with warranty terms covering the material in this document that conflict with these terms, the warranty terms in the separate agreement shall control.

Technology Licenses
The hardware and/or software described in this document are furnished under a license and may be used or copied only in accordance with the terms of such license.

Restricted Rights Legend
U.S. Government Restricted Rights. Software and technical data rights granted to the federal government include only those rights customarily provided to end user customers. Agilent provides this customary commercial license in Software and technical data pursuant to FAR 12.211 (Technical Data) and 12.212 (Computer Software) and, for the Department of Defense, DFARS 252.227-7015 (Technical Data - Commercial Items) and DFARS 227.7202-3 (Rights in Commercial Computer Software or Computer Software Documentation).

Safety Notices

CAUTION
A CAUTION notice denotes a hazard. It calls attention to an operating procedure, practice, or the like that, if not correctly performed or adhered to, could result in damage to the product or loss of important data. Do not proceed beyond a CAUTION notice until the indicated conditions are fully understood and met.

WARNING
A WARNING notice denotes a hazard. It calls attention to an operating procedure, practice, or the like that, if not correctly performed or adhered to, could result in personal injury or death. Do not proceed beyond a WARNING notice until the indicated conditions are fully understood and met.
In This Guide

This guide covers following module: NovoSampler Q

1 Prologue
This chapter describes the purpose and scope of this guide, symbols used in this guide, glossary, safety and limitations, Agilent regulatory compliance statement and technical support information.

2 Introduction
This chapter provides overview of NovoSampler Q, including product overview, system requirements, sample mixing, carryover, work mode and sample volume.

3 Installation
This chapter provides information required to install NovoSampler Q, including installation warnings, space and environmental requirements, instructions for lifting and carrying, and installation procedures.

4 Instrument Operation
This chapter provides the procedures for NovoSampler Q startup and shutdown.

5 Sample Acquisition
This chapter describes the sample acquisition process using NovoSampler Q.

6 System Maintenance
This chapter describes the procedures to maintain NovoSampler Q.

The NovoSampler Q frequently comes into contact with the experimental sample. To prevent corrosion of the instrument, periodically clean the outer and inner surfaces of the NovoSampler Q.

7 Troubleshooting
This section describes errors and possible solutions related to the NovoSampler Q.

8 Version History

Appendix A: NovoSampler Q Technical Specifications
In This Guide

This chapter lists technical specifications of NovoSampler Q.
## Contents

### In This Guide

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using this Guide</td>
<td>9</td>
</tr>
<tr>
<td>Symbols</td>
<td>9</td>
</tr>
<tr>
<td>Glossary</td>
<td>10</td>
</tr>
<tr>
<td>Safety and Limitations</td>
<td>12</td>
</tr>
<tr>
<td>General Safety</td>
<td>13</td>
</tr>
<tr>
<td>Electrical Safety</td>
<td>15</td>
</tr>
<tr>
<td>Biosafety</td>
<td>15</td>
</tr>
<tr>
<td>Limitations</td>
<td>16</td>
</tr>
<tr>
<td>Agilent Regulatory Compliance Statement</td>
<td>17</td>
</tr>
<tr>
<td>CE Compliance</td>
<td>17</td>
</tr>
<tr>
<td>Electromagnetic Compatibility</td>
<td>17</td>
</tr>
<tr>
<td>EMC Declaration for South Korea</td>
<td>19</td>
</tr>
<tr>
<td>Sound Emission Certification for Federal Republic of Germany</td>
<td>19</td>
</tr>
<tr>
<td>Waste Electrical and Electronic Equipment (WEEE) Directive</td>
<td>19</td>
</tr>
<tr>
<td>Regulatory Compliance Identification Number</td>
<td>19</td>
</tr>
<tr>
<td>Technical Support</td>
<td>20</td>
</tr>
</tbody>
</table>

### Introduction

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>21</td>
</tr>
<tr>
<td>System Requirements</td>
<td>24</td>
</tr>
<tr>
<td>Compatible Agilent Flow Cytometers</td>
<td>24</td>
</tr>
</tbody>
</table>
## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software</td>
<td>24</td>
</tr>
<tr>
<td>Workstation</td>
<td>24</td>
</tr>
<tr>
<td>Compatible Plates and Tubes</td>
<td>24</td>
</tr>
<tr>
<td>Sample Mixing</td>
<td>25</td>
</tr>
<tr>
<td>Carryover</td>
<td>25</td>
</tr>
<tr>
<td>Work Mode</td>
<td>25</td>
</tr>
<tr>
<td>Sample Volume</td>
<td>27</td>
</tr>
<tr>
<td>3  Installation</td>
<td>31</td>
</tr>
<tr>
<td>Installation Warnings</td>
<td>31</td>
</tr>
<tr>
<td>Space Requirements</td>
<td>31</td>
</tr>
<tr>
<td>Environmental Requirements</td>
<td>32</td>
</tr>
<tr>
<td>Instruction for Lifting and Carrying</td>
<td>32</td>
</tr>
<tr>
<td>Install NovoSampler Q</td>
<td>32</td>
</tr>
<tr>
<td>4  Instrument Operation</td>
<td>37</td>
</tr>
<tr>
<td>NovoSampler Q Start-up</td>
<td>37</td>
</tr>
<tr>
<td>Pre-Inspection</td>
<td>37</td>
</tr>
<tr>
<td>Power on NovoSampler Q</td>
<td>37</td>
</tr>
<tr>
<td>Calibrate NovoSampler Q</td>
<td>38</td>
</tr>
<tr>
<td>Shut down NovoSampler Q</td>
<td>39</td>
</tr>
<tr>
<td>5  Sample Acquisition</td>
<td>41</td>
</tr>
<tr>
<td>Preparation</td>
<td>41</td>
</tr>
<tr>
<td>Experiment Setup</td>
<td>42</td>
</tr>
<tr>
<td>Instrument QC Test</td>
<td>43</td>
</tr>
<tr>
<td>Single Sample Acquisition</td>
<td>44</td>
</tr>
<tr>
<td>Edit Work List</td>
<td>46</td>
</tr>
</tbody>
</table>
This page is intentionally left blank.
1 Prologue

This chapter describes the purpose and scope of this guide, symbols used in this guide, glossary, safety and limitations, Agilent regulatory compliance statement and technical support information.

Using this Guide

This guide describes the information and procedures to install, operate, maintain, and troubleshoot NovoSampler Q equipped for Agilent flow cytometer.

For additional information about Agilent flow cytometer, please refer to associated Agilent flow cytometer operator’s guide. For additional information about NovoExpress software, please refer to NovoExpress Software Guide.

Symbols

The following table lists the symbols used in this guide.

<table>
<thead>
<tr>
<th>Table 1</th>
<th>Symbols used in this guide</th>
</tr>
</thead>
<tbody>
<tr>
<td>Symbol</td>
<td>Meaning</td>
</tr>
<tr>
<td>![BIOHAZARD]</td>
<td>BIOHAZARD</td>
</tr>
<tr>
<td>![WARNING]</td>
<td>WARNING</td>
</tr>
<tr>
<td>![SHOCK HAZARD]</td>
<td>SHOCK HAZARD</td>
</tr>
</tbody>
</table>
Prologue

The following precaution labels appear on Agilent flow cytometer and associated accessories to indicate a potential hazard. Please do not remove these labels. Use appropriate precaution to avoid injury by the indicated hazard. Please refer to Safety and Limitations in this guide for more information.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Meaning</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>BIOHAZARD</td>
<td>This symbol indicates that certain precautions must be taken when working with potentially infectious biological specimens and materials.</td>
</tr>
<tr>
<td></td>
<td>MOVING PARTS</td>
<td>This label indicates the moving parts in the instrument. Be careful during the operation.</td>
</tr>
</tbody>
</table>

Glossary

The following table lists the glossary which may appear in this guide.

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADC</td>
<td>Analog-to-Digital Converter</td>
</tr>
<tr>
<td>Alexa Fluor</td>
<td>Alexa Fluor Dye</td>
</tr>
<tr>
<td>AmCyan</td>
<td>AmCyan Fluorescent Protein Dye</td>
</tr>
<tr>
<td>APC</td>
<td>Allophycocyanin Dye</td>
</tr>
<tr>
<td>APC-Cy7</td>
<td>APC and Cyanine 7 Tandem Dye</td>
</tr>
<tr>
<td>APD</td>
<td>Avalanche Photodiode</td>
</tr>
<tr>
<td>BP</td>
<td>Band Pass</td>
</tr>
<tr>
<td>BUV</td>
<td>Brilliant Ultraviolet</td>
</tr>
<tr>
<td>BV</td>
<td>Brilliant Violet</td>
</tr>
<tr>
<td>BXXX</td>
<td>488 nm (blue) laser excited fluorescence channels or photodetectors. For example, B572 denotes the 572/28 channel excited by the 488 nm laser, and so on.</td>
</tr>
<tr>
<td>CSV</td>
<td>Comma-Separated Values</td>
</tr>
</tbody>
</table>
### Table 3  Glossary used in this guide

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CV</td>
<td>Coefficient of Variation</td>
</tr>
<tr>
<td>EYFP</td>
<td>Enhanced Yellow Fluorescent Protein Dye</td>
</tr>
<tr>
<td>FCS</td>
<td>Flow Cytometry Standard</td>
</tr>
<tr>
<td>FITC</td>
<td>Fluorescein Isothiocyanate Dye</td>
</tr>
<tr>
<td>FPGA</td>
<td>Field Programmable Gate Array</td>
</tr>
<tr>
<td>FRM</td>
<td>Full Reflection Mirror</td>
</tr>
<tr>
<td>FSC</td>
<td>Forward Scatter, Forward Scattered Light</td>
</tr>
<tr>
<td>HPCV</td>
<td>Half-Peak Coefficient of Variation</td>
</tr>
<tr>
<td>LP</td>
<td>Long Pass</td>
</tr>
<tr>
<td>MESF</td>
<td>Molecules of Equivalent Soluble Fluorochrome</td>
</tr>
<tr>
<td>MFI</td>
<td>Mean Fluorescence Intensity</td>
</tr>
<tr>
<td>Pacific Blue</td>
<td>Pacific Blue Dye</td>
</tr>
<tr>
<td>Pacific Orange</td>
<td>Pacific Orange Dye</td>
</tr>
<tr>
<td>PD</td>
<td>Photodiode</td>
</tr>
<tr>
<td>PE</td>
<td>Phycoerythrin Dye</td>
</tr>
<tr>
<td>PE-Alexa Fluor</td>
<td>Phycoerythrin and Alexa Fluor Tandem Dye</td>
</tr>
<tr>
<td>PE-Cy5</td>
<td>Phycoerythrin and Cyanine 5 Tandem Dye</td>
</tr>
<tr>
<td>PE-Cy5.5</td>
<td>Phycoerythrin and Cyanine 5.5 Tandem Dye</td>
</tr>
<tr>
<td>PE-Cy7</td>
<td>Phycoerythrin and Cyanine 7 Tandem Dye</td>
</tr>
<tr>
<td>PerCP</td>
<td>Peridinin Chlorophyll Protein Dye</td>
</tr>
<tr>
<td>PerCP-Cy5.5</td>
<td>Peridinin Chlorophyll Protein and Cyanine 5.5 Tandem Dye</td>
</tr>
<tr>
<td>PerCP-eFluor</td>
<td>Peridinin Chlorophyll Protein and eFluor Tandem Dye</td>
</tr>
<tr>
<td>PE-Texas Red</td>
<td>Phycoerythrin-Texas Red Dye</td>
</tr>
<tr>
<td>PI</td>
<td>Propidium Iodide Dye</td>
</tr>
<tr>
<td>PMT</td>
<td>Photomultiplier Tube</td>
</tr>
<tr>
<td>Qdot</td>
<td>Qdot Dye</td>
</tr>
<tr>
<td>RXXX</td>
<td>637 nm or 640 nm (red) laser excited fluorescence channels or photodetectors. For example, R695 denotes the 695/40 channel excited by the 637 nm laser, and so on.</td>
</tr>
<tr>
<td>SD</td>
<td>Standard Deviation</td>
</tr>
<tr>
<td>SIP</td>
<td>Sample Injection Probe</td>
</tr>
</tbody>
</table>
## Table 3  Glossary used in this guide

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SiPM</td>
<td>Silicon Photo Multiplier</td>
</tr>
<tr>
<td>SP</td>
<td>Short Pass</td>
</tr>
<tr>
<td>SSC</td>
<td>Side Scatter</td>
</tr>
<tr>
<td>TEC</td>
<td>Thermoelectric Cooling</td>
</tr>
<tr>
<td>UVXXX</td>
<td>349 nm (ultraviolet) laser excited fluorescence channels or photodetectors. For example, UV615 denotes the 615/20 channel excited by the 349 nm laser, and so on.</td>
</tr>
<tr>
<td>VXXX</td>
<td>405 nm (violet) laser excited fluorescence channels or photodetectors. For example, V445 denotes the 445/45 channel excited by the 405 nm laser, and so on.</td>
</tr>
<tr>
<td>YXXX</td>
<td>561 nm (yellow) laser excited fluorescence channels or photodetectors. For example, Y586 denotes the 586/20 channel excited by the 561 nm laser, and so on.</td>
</tr>
</tbody>
</table>

Cy is a trademark of GE Healthcare/Amersham Biosciences.

Brilliant Violet is a trademark of Sirigen Group, Ltd.

Pacific Blue and Pacific Orange are trademarks of Life Technologies Corporation.

Alexa Fluor and Texas Red are registered trademarks of Life Technologies Corporation.

Qdot is a registered trademark of Quantum Dot Corporation.

eFluor is a registered trademark of eBioscience, Inc.

BD Horizon Brilliant Ultraviolet (BUV) is a trademark of Becton, Dickinson and Company or its affiliates.

PerCP: US patent 4,876,190

APC-Cy7: US patent 5,714,386

PE-Cy7: US patent 4,542,104

## Safety and Limitations

Agilent flow cytometers and associated accessories are limited to be operated by professionals trained by Agilent Technologies or an authorized representative. Agilent flow cytometer incorporates safety measures to protect the operator. Please refer to this guide to operate the instrument in strict accordance with the instructions and in accordance with the provisions of instrument maintenance and repair. Please ensure that the safety information can be found at any time. The
Prologue

instrument may be damaged if it is operated under any conditions that are not described in this guide.

General Safety

The following general safety precautions must be observed during all phases of operation of this instrument. Failure to comply with these precautions or with specific warnings or operation instructions in the operator’s guide violates safety standards of design, manufacture, and intended use of the instrument. Agilent Technologies assumes no liability for the customer’s failure to comply with these requirements.

CAUTION

Do not use this product in any manner not specified by the manufacturer. The protective features of this product may be impaired if it is used in a manner not specified in the operation instructions.
WARNING
Do not operate the instrument in the presence of flammable gases or fumes.

WARNING
Do not remove the instrument cover. Only Agilent authorized personnel are allowed to remove instrument covers. Always disconnect the power cables and any external circuits before removing the instrument cover.

WARNING
Do not modify the instrument. Do not install substitute parts or perform any unauthorized modification to the product. Return the product to an Agilent Sales and Service Office for service and repair to ensure that safety features are maintained.

WARNING
Instruments that appear damaged or defective should be made inoperative and secured against unintended operation until they can be repaired by qualified service personnel.

WARNING
The handling of toxic and hazardous solvents and flammable liquids can hold health risks. When working with solvents, ensure to observe appropriate safety procedures (for example, goggles, safety gloves and protective clothing) as described in the material safety data sheet supplied by the solvent vendor, especially when toxic or hazardous solvents and flammable liquids are used. Do not use solvents with an auto-ignition temperature below 200°C.

WARNING
When operating the instrument, keep your hands and clothing away from the instrument. Do not touch the sample injection probe (SIP) when the instrument is in operation. Mechanical movable parts within the instrument can pinch or cause injury to hands or fingers.

WARNING
The sample injection probe is a mechanical movable part and may pinch or injure your fingers. To prevent accidents, do not put your hand underneath the sample injection probe during the sample acquisition process. Also, when placing or removing the sample tube, do not put your hand underneath the sample injection probe.
CAUTION
Do not place any heavy objects on top of the instrument. Doing so may cause damage to the instrument, resulting in compromised instrument performance and abnormal data.

WARNING
Regarding the restrictions on the use of reagents, please see the relevant package insert and technical data sheet of the reagents.

Electrical Safety

WARNING
To prevent electrical shock and instrument damage, please follow the guidelines listed below.

- Unless otherwise specified, turn off the power switch and unplug the power cord of Agilent flow cytometer before servicing the Agilent flow cytometer and accessories.
- If leaks are detected, immediately turn off the power by pressing and holding the power button on the front of the Agilent flow cytometer for about 6-7 seconds. Immediately contact your local Agilent Technologies representative for support.
- If the communication cable between Agilent flow cytometer and accessories becomes frayed, broken, or damaged, please contact Agilent Technologies. Do not replace with a lower rated cable. If the equipment is been used in a manner which is not specified by Agilent Technologies, the protection provide by the equipment may be impaired.

Biosafety

WARNING
All biological specimens and materials in contact with biological specimens are potentially biohazardous. In order to avoid exposure to biohazardous material, be sure to follow the guidelines listed below.
Prologue

- Treat and handle all biological specimens and materials as if they are capable of transmitting infection. Dispose of waste using proper precautions and in accordance with local regulations. Never pipette by mouth.

- Avoid directly touching the biological specimens and waste. Wear suitable protective clothing, eyewear, and gloves when handling biological specimens and materials. If the biological samples accidentally contact with the skin, follow proper work safety procedures and immediately consult a medical professional.

- Gloves must be worn when manually loading the sample to the sample holder on the instrument.

- Reagents, including the sheath fluid, cleaning solution, and rinsing solution, may cause damage to the skin. Be cautious around sheath fluid, cleaning solution, and rinsing solution, and prevent direct contact with hands and clothes. If there has been accidental contact with hands or clothing, immediately rinse with soap and tap water. If it gets into eyes, immediately rinse with plenty of water and consult a medical professional.

- Sheath fluid, cleaning solution, rinsing solution, and waste may contain materials controlled by contamination regulations and emission standards. Please follow local regulations and guidelines for proper disposal.

- Expose waste container contents to bleach (10% of total volume) for 30 minutes before disposal. Dispose of waste in accordance with local regulations. Use proper precaution and wear suitable protective clothing, eyewear, and gloves when disposing of waste.

- Prevent waste overflow by emptying the waste container frequently or whenever the system gives Waste is Full warning.

- Be sure to place the second sample tube only after the rinsing procedure is fully completed for the previous sample. Otherwise, there is possibility that the content from the previous sample may contaminate or dilute the second sample, or even cause the second sample to overflow which may lead to exposure to biohazardous material.

Limitations

Agilent Technologies provides the software and workstation that are intended for running the Agilent flow cytometer. Buyers/users are responsible to ensure that all software, transmitted media, and electronic documents are virus free. If the workstation is used with a network connection, buyers/users are responsible for installation and maintenance of up-to-date virus protection software. Agilent Technologies does not provide warranty with respect to the workstation remaining
virus free after installation. Agilent Technologies is not liable for any claims related to or resulting from buyer/user’s failure to install and maintain virus protection.

**WARNING**  
Do not use the instrument, workstation, and other parts supplied by Agilent Technologies in an oxygen-enriched atmosphere.

**WARNING**  
Do not use the instrument, workstation, and other parts supplied by Agilent Technologies with flammable liquid/explosive gas or reagents.

**WARNING**  
Do not use the expired consumables and reagents.

**Agilent Regulatory Compliance Statement**

**CE Compliance**

Your Agilent instrument has been designed to comply with the requirements of the applicable directives of the European Union, such as Electromagnetic Compatibility (EMC) Directive, Low Voltage Directive (LVD), Machinery Directive (MD), RoHS Directive, etc. Agilent has confirmed that each product complies with the relevant Directives by testing samples against the harmonized EN (European Norm) standards published on the Official Journal of the European Union (OJEU).

Proof that a product complies with these directives is indicated by:

- the CE Marking appearing on the rear of the product, and
- the documentation package that accompanies the product containing a copy of the Declaration of Conformity. The Declaration of Conformity is the legal declaration by Agilent that the product complies with the relevant directives listed above, and shows the EN standards to which the product was tested to demonstrate compliance.

**Electromagnetic Compatibility**

This product conforms to the following regulations on Electromagnetic Compatibility (EMC) and Radio Frequency Interference (RFI):
Prologue

- CISPR 11/EN 55011: Group 1, Class A
- IEC/EN 61326-1
- AUS/NZ
- Canada ICES-001 (This ISM device complies with Canadian ICES-001. Cet appareil ISM est conforme à la norme NMB-001 du Canada).

**Group 1 ISM equipment**: group 1 contains all Industrial, Scientific and Medical (ISM) equipment in which there is intentionally generated and/or used conductively coupled radio- frequency energy which is necessary for the internal functioning of the equipment itself.

**Class A equipment** is equipment suitable for use in all establishments other than domestic and those directly connected to a low voltage power supply network which supplies buildings used for domestic purposes.

This device complies with the requirements of CISPR11, Group 1, Class A as radiation professional equipment. Therefore, there may be potential difficulties in ensuring electromagnetic compatibility in other environments, due to conducted as well as radiated disturbances.

If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try one or more of the following measures:

1. Relocate the radio or antenna.
2. Move the device away from the radio or television.
3. Plug the device into a different electrical outlet, so that the device and the radio or television are on separate electrical circuits.
4. Make sure that all peripheral devices are also certified.
5. Make sure that appropriate cables are used to connect the device to peripheral equipment.
6. Consult your equipment dealer, Agilent Technologies, or an experienced technician for assistance.

Changes or modifications not expressly approved by Agilent Technologies could void the user’s authority to operate the equipment.

**Class B equipment** is equipment suitable for use in domestic establishments and in establishments directly connected to a low voltage power supply network which supplies buildings used for domestic purposes.
EMC Declaration for South Korea

사용자안내문

This equipment has been evaluated for its suitability for use in a commercial environment. When used in a domestic environment, there is a risk of radio interference.

이 기기는 업무용 환경에서 사용할 목적으로 적합성평가를 받은 기기로서 가정용 환경에서 사용하는 경우 전파간섭의 우려가 있습니다.

※ 사용자 안내문은 "업무용 방송통신기자재"에만 적용한다.

Sound Emission Certification for Federal Republic of Germany

Sound pressure

Sound pressure Lp < 70 dB(A) according to DIN-EN 27779.

Schalldruckpegel

Schalldruckpegel LP < 70 dB(A) nach DIN-EN 27779.

Waste Electrical and Electronic Equipment (WEEE) Directive

This product complies with the European WEEE Directive marking requirements. The affixed label indicates that you must not discard this electrical/electronic product in domestic household waste.

NOTE

Do not dispose of in domestic household waste.

To return unwanted products, contact your local Agilent office, or see https://www.agilent.com for more information.

Regulatory Compliance Identification Number

For the purpose of regulatory compliance certifications and identification, your product may have been assigned a unique Agilent Regulatory Model Number (RMN). This RMN can be found on the product nameplate label, along with all required approval markings and information. When requesting compliance information for this product, always refer to this RMN. The RMN should not be confused with the marketing name or model number of the product.
Technical Support

If there are operating or technical questions, please refer to the sections relating to the instrument operation in this guide. If a problem occurs, refer to the Troubleshooting section in this guide for solutions. For additional technical support, please contact your local Agilent Technologies representative or distributor. When contacting Agilent Technologies, be sure to provide the following information:

- The product name, product model and serial number.
- Usage history of the instrument.
- Instrument status information on the status bar from the NovoExpress software. Or if there is a warning or error message, please also provide that information.
- Experiment information conducted on the instrument, if not confidential.
- Details of recent instrument QC test.

For support within the US, please call 800-227-9770.

For support within China, please call 800-820-3278 (Desk) or 400-820-3278 (Cell).

For users in other countries or regions, contact your local Agilent Technologies representatives or distributors, which may be found at https://www.agilent.com.

NOTE

When encountering an issue during operation of Agilent flow cytometer and associated accessories, it is highly recommended to submit a Technical Support Request by clicking Home > Technical Support Request in the NovoExpress main window. The Technical Support Request Creation Wizard automatically collects the instrument configurations, system logs, current screenshot, current experiment file and other information that helps in the diagnosis and troubleshooting of Agilent flow cytometer. User can also attach any other files using this function. Please refer to NovoExpress Software Guide for detailed information on this function.
2 Introduction

This chapter provides overview of NovoSampler Q, including product overview, system requirements, sample mixing, carryover, work mode and sample volume.

Overview

NovoSampler Q is an optional sample handling module for the Agilent flow cytometer to achieve automatic collection of samples in compatible sample plates or tubes. NovoSampler Q uses an integrated orbital shaker for efficient mixing of the sample in each well and achieve high uniformity across the entire multi-well plate for volumetric absolute counting. As an example, Figure 1 shows overview of an Agilent flow cytometer with NovoSampler Q, NovoCyte Workstation and NovoCyte Fluidics Station II.

Please refer to Compatible Agilent Flow Cytometers in this guide for list of Agilent flow cytometers which can be equipped with NovoSampler Q.

Figure 1. Agilent Flow Cytometer Equipped with NovoSampler Q

The NovoSampler Q has a built-in orbital shaker to hold the multi-well plate and mix the sample, a cover, LED light and status indication LED, as shown in Figure 2.
Introduction

**WARNING**

NovoSampler Q contains moving parts which may cause injury. To prevent accidents, ensure that the cover to the NovoSampler Q is closed during sample acquisition. The cover should only be opened when loading samples or when required for maintenance. If the cover is opened during sample acquisition, the NovoSampler Q will stop running and an error message will appear on the NovoExpress Software.

The orbital shaker in NovoSampler Q is shown in Figure 3. The shaker is able to hold compatible multi-well plates (e.g. 96 well plate) and Agilent manufactured tube racks (e.g. Agilent Flow Cytometer 40 tube rack). Please refer to **Compatible Plates and Tubes** in this guide for more details.
Before loading multi-well plates or tube racks, identify the correct orientation for loading into the orbital shaker. Make sure they are positioned properly on the orbital shaker. The plate or tube rack should be placed onto the surface of the orbital shaker without any tilting. Incorrect placement may cause misalignment between the sample wells and sample injection probe, resulting in damage to the sample injection probe or the orbital shaker.

The inner surface of the NovoSampler Q may contact residual biohazardous material. When working with NovoSampler Q, use appropriate protective equipment, including gloves, clothing, and eyewear.

Agilent Flow Cytometer 40 tube rack compatible with 12 × 75 mm tubes is included with the purchase of NovoSampler Q.

Use only the Agilent manufactured 40 tube rack, 24 tube cooling rack and 96-well plate cooling box on the NovoSampler Q. Using any other type of tube rack or cooling box may cause severe damage to the instrument and void the warranty.

The NovoSampler Q status indication LED indicates the status of the NovoSampler Q. The color of the status indication LED and the corresponding NovoSampler Q status are listed in Table 4.

<table>
<thead>
<tr>
<th>LED Color</th>
<th>Status of the NovoSampler Q</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>Normal.</td>
</tr>
<tr>
<td>Orange</td>
<td>NovoSampler Q warning. Click the status bar in the NovoExpress Software to review the warning.</td>
</tr>
<tr>
<td>Red</td>
<td>NovoSampler Q error. Click on the status bar in the NovoExpress Software to review the error.</td>
</tr>
</tbody>
</table>
Introduction

For additional information regarding warnings and errors, refer to Troubleshooting in this guide.

System Requirements

Compatible Agilent Flow Cytometers
- NovoCyte Quanteon Flow Cytometer
- NovoCyte Advanteon Flow Cytometer
- NovoCyte Penteon Flow Cytometer

Software
NovoExpress software.

Workstation
NovoCyte Workstation. For details, refer to associated Agilent flow cytometer operator’s guide.

Compatible Plates and Tubes
NovoSampler Q is compatible with the following plates and tubes:
- 12 × 75 mm tubes with Agilent Flow Cytometer 40 tube rack
- 96-well plates (V-bottom)
- 96-well plates (U-bottom)
- 96-well plates (flat-bottom)
- 48-well plates
- 24-well plates
- 384-well plates
- 12 × 75 mm tubes with Agilent Flow Cytometer 24 tube cooling rack
- 96-well plate (V-bottom) with Agilent Flow Cytometer 96-well plate cooling box
- 96-well plate (U-bottom) with Agilent Flow Cytometer 96-well plate cooling box
- 96-well plate (flat-bottom) with Agilent Flow Cytometer 96-well plate cooling box
Introduction

Sample Mixing

NovoSampler Q has a mixing function to help keep the sample in suspension. This function achieves effective mixing with all compatible plates. Users can set the appropriate mixing conditions for their specific sample, as the tendency of sample to settle depends on the characteristics of the sample (sample density, liquid viscosity, etc.).

NOTE
For setting the mixing conditions, see Experiment Setup in this guide for more information.

Carryover

NovoSampler Q can automatically rinse the sample injection probe and fluidic tubing to reduce cross-contamination between samples. When this function is used, the NovoSampler Q has a carryover rate of less than 0.1%.

NOTE
For setting sampling conditions, see Experiment Setup in this guide for more information.

Work Mode

NovoSampler Q can work in Standard, High-Throughput or Custom mode. User needs to select the work mode in Plate Manager window of NovoExpress software. When NovoSampler Q is selected to work in Standard and High-Throughput mode, the software will automatically apply the default settings for mixing parameters (e.g. mixing cycle, rinse cycle, mixing speed, acceleration, mixing duration, sampling volume and flow rate). User can only customize these settings when Custom mode is selected. Please refer to NovoExpress Software Guide for more details.

Table 5 summarizes the working conditions and the throughput for NovoSampler Q when it works in Standard and High-Throughput mode.

NOTE
When NovoSampler Q is working in Custom Mode, the work conditions and the throughput are user defined and can be changed based on application needs.
### Table 5  Default Working Condition and Throughput of NovoSampler Q When Working in Standard and High-Throughput Mode

<table>
<thead>
<tr>
<th>Working Condition</th>
<th>Standard Mode</th>
<th>High-Throughput</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample flow rate (µL/min)</td>
<td>66</td>
<td>120</td>
</tr>
<tr>
<td>Sampling volume (µL)</td>
<td>24-well plate: 10</td>
<td>24-well plate: 10</td>
</tr>
<tr>
<td></td>
<td>48-well plate: 10</td>
<td>48-well plate: 10</td>
</tr>
<tr>
<td></td>
<td>96-well plate (U-, V-, Flat Bottom): 5</td>
<td>96-well plate (U-, V-, Flat Bottom): 5</td>
</tr>
<tr>
<td></td>
<td>384-well plate: 5</td>
<td>384-well plate: 5</td>
</tr>
<tr>
<td></td>
<td>12 X 75 mm Tube with NovoSampler</td>
<td>12 X 75 mm Tube with NovoSampler</td>
</tr>
<tr>
<td></td>
<td>40 tube rack: 10</td>
<td>40 tube rack: 10</td>
</tr>
<tr>
<td></td>
<td>12 X 75 mm Tube with NovoSampler</td>
<td>12 X 75 mm Tube with NovoSampler</td>
</tr>
<tr>
<td></td>
<td>24 tube cooling rack: 10</td>
<td>24 tube cooling rack: 10</td>
</tr>
<tr>
<td></td>
<td>96-well plate (U-, V-, Flat Bottom) with cooling box: 5</td>
<td>96-well plate (U-, V-, Flat Bottom) with cooling box: 5</td>
</tr>
<tr>
<td>Mix (cycles)</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>Rinse (cycles)</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>Mixing Speed (rpm)</td>
<td>24-well plate: 2500</td>
<td>24-well plate: 2500</td>
</tr>
<tr>
<td></td>
<td>48-well plate: 1500</td>
<td>48-well plate: 1500</td>
</tr>
<tr>
<td></td>
<td>96-well plate (U-, V-, Flat Bottom): 1500</td>
<td>96-well plate (U-, V-, Flat Bottom): 1500</td>
</tr>
<tr>
<td></td>
<td>384-well plate: 2500</td>
<td>384-well plate: 2500</td>
</tr>
<tr>
<td></td>
<td>12 X 75 mm Tube with NovoSampler</td>
<td>12 X 75 mm Tube with NovoSampler</td>
</tr>
<tr>
<td></td>
<td>40 tube rack: 1000</td>
<td>40 tube rack: 1000</td>
</tr>
<tr>
<td></td>
<td>12 X 75 mm Tube with NovoSampler</td>
<td>12 X 75 mm Tube with NovoSampler</td>
</tr>
<tr>
<td></td>
<td>24 tube cooling rack: 1000</td>
<td>24 tube cooling rack: 1000</td>
</tr>
<tr>
<td></td>
<td>96-well plate (U-, V-, Flat Bottom) with cooling box: 1500</td>
<td>96-well plate (U-, V-, Flat Bottom) with cooling box: 1500</td>
</tr>
<tr>
<td>Mixing Duration (s)</td>
<td>24-well plate: 10</td>
<td>24-well plate: 4</td>
</tr>
<tr>
<td></td>
<td>48-well plate: 10</td>
<td>48-well plate: 5</td>
</tr>
<tr>
<td></td>
<td>96-well plate (U-, V-, Flat Bottom): 8</td>
<td>96-well plate (U-, V-, Flat Bottom): 3</td>
</tr>
<tr>
<td></td>
<td>384-well plate: 8</td>
<td>384-well plate: 2</td>
</tr>
<tr>
<td></td>
<td>12 X 75 mm Tube with NovoSampler</td>
<td>12 X 75 mm Tube with NovoSampler</td>
</tr>
<tr>
<td></td>
<td>40 tube rack: 10</td>
<td>40 tube rack: 5</td>
</tr>
<tr>
<td></td>
<td>12 X 75 mm Tube with NovoSampler</td>
<td>12 X 75 mm Tube with NovoSampler</td>
</tr>
<tr>
<td></td>
<td>24 tube cooling rack: 10</td>
<td>24 tube cooling rack: 5</td>
</tr>
<tr>
<td></td>
<td>96-well plate (U-, V-, Flat Bottom) with cooling box: 8</td>
<td>96-well plate (U-, V-, Flat Bottom) with cooling box: 3</td>
</tr>
<tr>
<td>Acceleration (s)</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>Throughput (min)</td>
<td>24-well plate: &lt; 11</td>
<td>24-well plate: &lt; 7</td>
</tr>
<tr>
<td></td>
<td>48-well plate: &lt; 22</td>
<td>48-well plate: &lt; 13</td>
</tr>
<tr>
<td></td>
<td>96-well plate (U-, V-, Flat Bottom): &lt; 35</td>
<td>96-well plate (U-, V-, Flat Bottom): &lt; 20</td>
</tr>
<tr>
<td></td>
<td>384-well plate: &lt; 135</td>
<td>384-well plate: &lt; 80</td>
</tr>
<tr>
<td></td>
<td>12 X 75 mm Tube with NovoSampler</td>
<td>12 X 75 mm Tube with NovoSampler</td>
</tr>
<tr>
<td></td>
<td>40 tube rack: &lt; 18</td>
<td>40 tube rack: &lt; 11</td>
</tr>
</tbody>
</table>
Introduction

Table 5  Default Working Condition and Throughput of NovoSampler Q When Working in Standard and High-Throughput Mode

<table>
<thead>
<tr>
<th>Condition</th>
<th>Standard Mode/HT Mode</th>
<th>Custom Mode With Absolute Count Checked</th>
<th>Custom Mode With Absolute Count Unchecked</th>
</tr>
</thead>
<tbody>
<tr>
<td>12 X 75 mm Tube with NovoSampler 24 tube cooling rack: &lt;17</td>
<td>0.5</td>
<td>0.5</td>
<td>0.5</td>
</tr>
<tr>
<td>96-well plate (U-, V-, Flat Bottom) with cooling box: &lt; 35</td>
<td>265.0</td>
<td>265.0</td>
<td>265.0</td>
</tr>
<tr>
<td>12 X 75 mm Tube with NovoSampler 24 tube cooling rack: &lt; 11</td>
<td>0.5</td>
<td>0.5</td>
<td>0.5</td>
</tr>
<tr>
<td>96-well plate (U-, V-, Flat Bottom) with cooling box: &lt; 20</td>
<td>26.5</td>
<td>26.5</td>
<td>26.5</td>
</tr>
</tbody>
</table>

NOTE

When 384 well plate is used and NovoSampler Q is working in Standard mode, the sample will be mixed one cycle for every 6 wells.

Sample Volume

The minimum sample volume requirement for each plate and tube type used on NovoSampler Q is listed in Table 6.

Table 6  The Minimum Sampling and Sample Volume Requirement for Each Plate and Tube Type

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Plate Type</th>
<th>Standard Mode/HT Mode</th>
<th>Custom Mode With Absolute Count Checked</th>
<th>Custom Mode With Absolute Count Unchecked</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dead Volume (µL)</td>
<td>12 × 75 mm tube with 40 tube rack</td>
<td>0.5</td>
<td>0.5</td>
<td>0.5</td>
</tr>
<tr>
<td></td>
<td>24-well plates</td>
<td>265.0</td>
<td>265.0</td>
<td>265.0</td>
</tr>
<tr>
<td></td>
<td>48-well plates</td>
<td>90.0</td>
<td>90.0</td>
<td>90.0</td>
</tr>
<tr>
<td></td>
<td>96-well plates (flat-bottom)</td>
<td>26.5</td>
<td>26.5</td>
<td>26.5</td>
</tr>
<tr>
<td></td>
<td>96-well plates (V-bottom)</td>
<td>0.6</td>
<td>0.6</td>
<td>0.6</td>
</tr>
<tr>
<td></td>
<td>96-well plates (U-bottom)</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
</tr>
<tr>
<td></td>
<td>384-well plates</td>
<td>3.0</td>
<td>3.0</td>
<td>3.0</td>
</tr>
<tr>
<td></td>
<td>12 X 75 mm Tube with 24 tube cooling rack</td>
<td>0.5</td>
<td>0.5</td>
<td>0.5</td>
</tr>
<tr>
<td></td>
<td>96-well plate (U-Bottom) with cooling box</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
</tr>
<tr>
<td></td>
<td>96-well plate (V-Bottom) with cooling box</td>
<td>0.6</td>
<td>0.6</td>
<td>0.6</td>
</tr>
<tr>
<td></td>
<td>96-well plate (Flat Bottom) with cooling box</td>
<td>26.5</td>
<td>26.5</td>
<td>26.5</td>
</tr>
</tbody>
</table>
Introduction

Table 6  The Minimum Sampling and Sample Volume Requirement for Each Plate and Tube Type

<table>
<thead>
<tr>
<th>Sampling Overhead Volume (µL)</th>
<th>All Plates and Racks</th>
<th>10</th>
<th>30</th>
<th>10</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum Sampling Volume (µL)</td>
<td>12 x 75 mm tube with 40 tube rack</td>
<td>10</td>
<td>5</td>
<td>5</td>
</tr>
<tr>
<td>24-well plates</td>
<td>10</td>
<td>5</td>
<td>5</td>
<td>5</td>
</tr>
<tr>
<td>48-well plates</td>
<td>10</td>
<td>5</td>
<td>5</td>
<td>5</td>
</tr>
<tr>
<td>96-well plates (U-, V- and flat-bottom)</td>
<td>5</td>
<td>5</td>
<td>5</td>
<td>5</td>
</tr>
<tr>
<td>384-well plates</td>
<td>5</td>
<td>5</td>
<td>5</td>
<td>5</td>
</tr>
<tr>
<td>12 X 75 mm Tube with 24 tube cooling rack</td>
<td>10</td>
<td>5</td>
<td>5</td>
<td>5</td>
</tr>
<tr>
<td>96-well plate (U-, V- and Flat Bottom) with cooling box</td>
<td>5</td>
<td>5</td>
<td>5</td>
<td>5</td>
</tr>
<tr>
<td>Minimum Sample Volume (µL)</td>
<td>12 x 75 mm tube with 40 tube rack</td>
<td>20.5</td>
<td>35.5</td>
<td>15.5</td>
</tr>
<tr>
<td>24-well plates</td>
<td>285</td>
<td>300</td>
<td>280</td>
<td></td>
</tr>
<tr>
<td>48-well plates</td>
<td>110</td>
<td>125</td>
<td>105</td>
<td></td>
</tr>
<tr>
<td>96-well plates (flat-bottom)</td>
<td>41.5</td>
<td>61.5</td>
<td>41.5</td>
<td></td>
</tr>
<tr>
<td>96-well plates (V-bottom)</td>
<td>15.6</td>
<td>35.6</td>
<td>15.6</td>
<td></td>
</tr>
<tr>
<td>96-well plates (U-bottom)</td>
<td>15</td>
<td>35</td>
<td>15</td>
<td></td>
</tr>
<tr>
<td>384-well plates</td>
<td>18</td>
<td>38</td>
<td>18</td>
<td></td>
</tr>
<tr>
<td>12 X 75 mm Tube with 24 tube cooling rack</td>
<td>20.5</td>
<td>35.5</td>
<td>15.5</td>
<td></td>
</tr>
<tr>
<td>96-well plate (U-Bottom) with cooling box</td>
<td>15</td>
<td>35</td>
<td>15</td>
<td></td>
</tr>
<tr>
<td>96-well plate (V-Bottom) with cooling box</td>
<td>15.6</td>
<td>35.6</td>
<td>15.6</td>
<td></td>
</tr>
<tr>
<td>96-well plate (Flat Bottom) with cooling box</td>
<td>41.5</td>
<td>61.5</td>
<td>41.5</td>
<td></td>
</tr>
</tbody>
</table>
Introduction

**NOTE**

**Dead Volume** is the volume of the sample remaining inside the sample tube or plate well that cannot be aspirated into sample injection probe after each sample acquisition. **Sampling Overhead Volume** is the volume of extra sample aspirated into the SIP during each sample acquisition. **Sampling Volume** is the volume of the sample user defined in the **Stop Condition. Sample Volume** is the volume of the sample user prepared and placed inside the sample tube or plate well before each sample run.

**NOTE**

**Minimum Sample Volume** is the minimum volume of sample user need prepare and place inside the sample tube or plate well. This volume is equal to the sum of Dead Volume, Sampling Overhead Volume and Sampling Volume.
3 Installation

This chapter provides information required to install NovoSampler Q, including installation warnings, space and environmental requirements, instructions for lifting and carrying, and installation procedures.

Installation Warnings

**WARNING**
Ensure NovoSampler Q is powered off and is not connected to Agilent flow cytometer before installing or relocating the instrument.

**WARNING**
Do not operate the instrument in an environment where potentially damaging liquids or gas are present.

**WARNING**
Do not loosen or remove any screws or parts other than those specifically described in the instructions for instrument installation or maintenance. Doing so may affect instrument performance and void the instrument warranty.

Space Requirements

A minimum space of 170 cm (W) × 80 cm (D) × 90 cm (H) is required to install both NovoSampler Q and Agilent flow cytometer with NovoCyte Fluidics Station II. Make sure there is at least 20 cm distance between the Agilent flow cytometer and the adjacent object (i.e. walls). Leave at least 10 cm distance between the Agilent flow cytometer and the NovoCyte Fluidics Station II.
Environmental Requirements

NovoSampler Q is designed to be used indoor. Please install and operate the NovoSampler Q with temperature of 15-32°C, and maximum relative humidity of 80%. Store the NovoSampler Q with temperature of 1-40°C, and maximum relative humidity of 80%. Failure to follow the environmental requirements may reduce the operating lifetime or cause damage to the NovoSampler Q.

Instruction for Lifting and Carrying

- Ensure to disconnect NovoSampler Q from connected Agilent flow cytometer before lifting or moving NovoSampler Q.
- Do not tilt NovoSampler Q when attempting to lift or move it. Damage to NovoSampler Q may occur.
- Gently lift or carry NovoSampler Q with proper lifting technique.

**WARNING**
To prevent accidents and to ensure the quality of the data, after Agilent Technologies professionals install the instrument, moving the instrument is not recommended. If any change of performance is observed, please contact your local Agilent Technologies representative.

Install NovoSampler Q

This section describes the procedures to install the NovoSampler Q. As an example, NovoCyte Quanteon Flow Cytometer is used for illustrating the detailed procedures. User can follow the similar procedures to install NovoSampler Q on NovoCyte Advanteon or Penteon Flow Cytometer.

**CAUTION**
Before installing the NovoSampler Q, the tube holder for manual sample acquisition must be removed.
Installation

7 To remove the tube holder, loosen the screws as shown in Figure 4 and remove the tube holder.

![Figure 4. Remove the Tube Holder](image)

8 Position the NovoSampler Q to the instrument as shown in Figure 5. Align the left and back side of the NovoSampler Q with the instrument and gently push the NovoSampler Q against the instrument.

**CAUTION** Ensure to place NovoSampler Q on a leveled surface. Ensure NovoSampler Q is closely in contact with the instrument (i.e. there is no gap between the NovoSampler Q and instrument on both left and back sides). Failure to do so may cause calibration failure or the collision of the sample injection probe to the sample plate during sample collection.

![Figure 5. Properly Positioning the NovoSampler Q with Agilent Flow Cytometer](image)
Installation

9 Open the cover of NovoSampler Q, locate two screw holes as shown in Figure 6. Align the two holes of the NovoSampler Q to the two holes on the instrument. Tighten the screws (Figure 7).

![Figure 6. Align the Two Holes of the NovoSampler Q](image1.jpg)

![Figure 7. Tighten the Screws](image2.jpg)

**CAUTION**
Use appropriate force (i.e., finger tight) when tightening the screws. Excessive force may result in damage. Ensure that the connections are tight, and that the sampler is stable during sample acquisition.

10 Connect the cable between the NovoSampler Q and the instrument as shown in Figure 8. Ensure to tighten the screws on the connectors (Figure 9).
Installation

Figure 8. Connect NovoSampler Q to Agilent Flow Cytometer

Figure 9. Screw on the Cable Connector
Installation

This page is intentionally left blank.
4 Instrument Operation

This chapter provides the procedures for NovoSampler Q startup and shutdown.

**NovoSampler Q Start-up**

**Pre-Inspection**

1. Check the power cords of the Agilent flow cytometer and NovoCyte Workstation. Ensure that they are securely connected to a power outlet.
2. Check that the connection between the NovoSampler Q and the instrument are correct and secure.
3. Make sure there is no gap between the NovoSampler Q and instrument on both left and back sides.
4. Check that the connection between the NovoCyte Workstation and the Agilent flow cytometer are correct and secure.
5. Check the NovoFlow sheath fluid container, the NovoRinse solution container, and the NovoClean solution container to make sure there are enough reagents inside. Follow the instructions described in Add Instrument Reagents in associated Agilent flow cytometer operator's guide to add more reagent to the container as needed.
6. Check the waste container to make sure the container is not full, follow the instructions described in Empty Waste in associated Agilent flow cytometer operator’s guide to empty the waste container.

**Power on NovoSampler Q**

Gently press the power switch on the front panel of the Agilent flow cytometer. NovoSampler Q will be automatically powered on once the Agilent flow cytometer is powered on. The LED status indicator should turn green, indicating that the NovoSampler Q is properly connected and powered on.
Instrument Operation

**NOTE**

User can also manually power on NovoSampler Q when Agilent flow cytometer is previously powered on. Click the Instrument > NovoSampler Q > Power Up from the NovoExpress software (Figure 10). The software will prompt a dialog box requesting to restart the NovoExpress software, as shown in Figure 11. Click Yes to restart the software.

![Figure 10. Power on NovoSampler Q](image)

**WARNING**

Unplug the power cord of Agilent flow cytometer immediately under emergent situation (e.g. electric shock).

Calibrate NovoSampler Q

When NovoSampler Q is newly installed, the software will prompt a window requesting to calibrate NovoSampler Q once the instrument is powered on.

Click Calibrate to start the calibration of the NovoSampler Q. Calibration can be postponed, but the software will not allow for samples to be collected until a calibration is performed successfully.

![Figure 12. Dialog Box to Indicate NovoSampler Q Calibration](image)
Instrument Operation

To manually start the NovoSampler Q calibration, click the Instrument > NovoSampler Q > Calibrate on the NovoExpress software.

For additional information on starting up Agilent flow cytometer, refer to the associated Agilent flow cytometer operator’s guide.

Before calibrating the NovoSampler Q, ensure to remove any plates from the orbital shaker. Plates or other items in the orbital shaker may result in a collision and damage to the instrument.

Shut down NovoSampler Q

When all experiments are completed for the day, shut down Agilent flow cytometer and NovoSampler Q using the following procedure:

1. Press the power button on the Agilent flow cytometer, or click on the Shut Down button in the Instrument tab of the NovoExpress Software. The light in the power button will start flashing, and the instrument will automatically start the shutdown cleaning process. After the shutdown cleaning process is completed, the instrument will be turned off automatically. NovoSampler Q will be automatically shut down once the instrument is shut down.

User can manually shut down NovoSampler Q only by clicking Instrument > NovoSampler Q > Power Down from NovoExpress software.

User can also check the Shutdown NovoCyte after plate run checkbox in Cytometer Control panel to automatically activate the shutdown function after all the defined samples have been acquired. Refer to NovoExpress Software Guide for more information.
Instrument Operation

NOTE
Agilent flow cytometer and NovoSampler Q can also be shut down through Schedule Power On & Off function from the Operation panel. If user enabled this function and the experiment is not completed at the scheduled power off time, the instrument will wait for up to 30 mins before shutting down the instrument. If the experiment still can't be completed after the 30 mins runs out (i.e. instrument is not in Ready status), the scheduled power off will be automatically canceled. For more details on enabling the Schedule Power On & Off function, please refer to NovoExpress Software Guide.

2 Close NovoExpress software.
3 Shut down the NovoCyte Workstation.
4 Add more reagent to NovoFlow, NovoClean and NovoRinse containers as needed.
5 Empty the waste container.

NOTE
For detailed information on adding reagent to NovoFlow, NovoClean and NovoRinse containers, please refer to Add Instrument Reagents in associated Agilent flow cytometer operator’s guide.

NOTE
For detailed information on emptying the waste container, please refer to Empty Waste in associated Agilent flow cytometer operator's guide.
This chapter describes the sample acquisition process using NovoSampler Q.

In this chapter, a 96-well plate will be used for sample acquisition. Firstly, a QC Test using Agilent Flow Cytometer QC Particles will be performed in well A1 of Agilent Flow Cytometer 40 tube rack. The Agilent CD3 FITC/CD8 PE/CD45 PerCP/CD4 APC Reagent will be used to prepare a single sample of human peripheral blood in well A2. The sample will be used to determine the gate for the lymphocyte subpopulation. Well A3, A4, A5, and A6 are compensation beads labeled respectively with FITC, PE, PerCP, and APC conjugated antibodies for automatic fluorescence compensation using NovoExpress software and generating the compensation matrix. In well B1 to E12, 48 samples will be created and analyzed for 24 specimens with 2 samples in each specimen. For each specimen, one sample will be stained with Agilent CD3 FITC/CD8 PE/CD45 PerCP/CD4 APC Reagent and the second sample will be stained with Agilent CD3 FITC/CD16+CD56 PE/CD45 PerCP/CD19 APC Reagent.

**Preparation**

Before using the NovoSampler Q for sample acquisition, please be familiar with the following operation and information:

- Instrument startup and shutdown procedures
- QC testing procedure
- NovoExpress Software’s Cytometer Settings, Work List and Experiment Manager panels
- NovoSampler Q sample volume requirements

**NOTE**

For additional information regarding the operation of the Agilent flow cytometer, refer to the associated Agilent flow cytometer operator’s guide.

**NOTE**

For additional information regarding using the NovoExpress Software, refer to the NovoExpress Software Guide.
Sample Acquisition

The recommended sample concentration is $1 \times 10^6$ cells/mL.

To avoid the termination of the plate run due to the lack of sheath fluid or a full waste container, before starting an automatic sample acquisition with NovoSampler Q, always make sure there is a sufficient volume of sheath fluid in the sheath fluid container and the waste container has enough capacity. Refer to associated Agilent flow cytometer operator’s guide for instructions to add instrument reagents and empty waste.

Experiment Setup

Start Agilent flow cytometer and NovoExpress Software according to the process described in the associated Agilent flow cytometer operator’s guide. As the flow cytometer powers on, the NovoSampler Q will also start and be ready to use.

Before sample acquisition using the NovoSampler Q, select the plate type from the Plate Manager panel (Figure 13). If the Plate Manager panel is not visible, check the box from View > Show > Plate Manager to open it. The plate type can then be selected from the Plate Type drop-down menu. In this example, the 96-well plate (U-bottom) is selected. For other compatible plate types, refer to Compatible Plates and Tubes in this guide.
Sample Acquisition

---

**CAUTION**

Before starting sample acquisition, ensure that the correct plate type is selected. An incorrectly selected plate type may result in the collision of the sample injection probe with the plate and could cause damage to the instrument.

---

**Instrument QC Test**

Quality Control (QC) test is used to monitor the performance of Agilent flow cytometer. Use the Agilent Flow Cytometer QC Particles daily after startup to QC the instrument and make sure it functions properly. Please refer to *NovoExpress Software Guide* for detailed instructions.
Single Sample Acquisition

This section describes the collection of a single sample of human peripheral blood prepared using the Agilent CD3 FITC/CD8 PE/CD45 PerCP/CD4 APC Reagent. The sample will be used to set up the gate for the lymphocyte subpopulation. Based on this single sample, settings can be optimized for other human peripheral blood samples in the example described in this chapter, including setting up a proper acquisition threshold and determining the gates for the lymphocyte subpopulation.

To begin the collection of the single sample in well A2, follow the procedure:

1. After the completion of the QC Test, the sample tray will return to the home position. After the sample tray moves to home position, open the NovoSampler Q cover and remove the sample plate.

2. Add 150 µL of the sample of human peripheral blood stained with Agilent CD3 FITC/CD8 PE/CD45 PerCP/CD4 APC Reagent to well A2 of the sample plate.

3. Place the sample plate onto the sample tray of the NovoSampler Q and close the cover.

4. In NovoExpress Software, create a new experiment file. Click the Next Sample button on the Cytometer Control panel to create a new sample (named A1: Sample1 by default) and specimen (named Specimen1 by default). Save the file to a specific folder on NovoCyte Workstation by clicking File > Save.

5. Setting conditions for sample acquisition is described in the Running Samples in associated Agilent flow cytometer operator’s guide. In this experiment, the parameters should be set to collect the Height parameter from FSC, SSC, B525, B667, R667 and Y586. The aliases for B525, B667, R667 and Y586 could be modified to CD3 FITC, CD8 PE, CD45 PerCP and CD4 APC, respectively. Set the stop condition to 50 µL. Set the sample flow rate to Low. Set the threshold to collect samples with FSC-H greater than 100,000.

The volume stop condition must be set when using NovoSampler Q.

6. Change the sample information. Set the Well ID as A2 using one of the two following methods:
   - Click Sample1 in the Experiment Manager panel to select the node (Figure 14). Right-click and select Rename. The Well ID can now be modified to A2.
Sample Acquisition

Figure 14. Modify Well ID in the Experiment Manager Panel

- In the **Active Sample Information** window of the Cytometer Control panel (Figure 15), click the sample name and modify the Well ID to **A2**.

Figure 15. Modify Well ID in the Cytometer Control Panel

NOTE

The well can be named from a range depending on the plate type selected from the **Plate Manager** panel. For example, if a 96-well plate is selected, the wells can range from A1 to H12. If a 24-well plate is selected, the wells can range from A1 to D6.

7 In the **Cytometer Control** panel, click the **Run Single Well** button to start sample acquisition from well A2.

8 In the Workspace, create a density plot by clicking the **Density Plot** button from the toolbar. Change the x-axis parameter to **CD45 PerCP-H** and the y-axis parameter to **SSC-H** (Figure 16). Use the **Zoom In** tool, to display the appropriate coordinate range for the sample. Draw an **Elliptical Gate** to gate the lymphocyte population on the plot and rename the gate as **Lymphocyte**.
Sample Acquisition

![Sample Acquisition](image)

**Figure 16.** Create Density Plot and Draw Lymphocyte Gate

### Edit Work List

In this section, the **Work List** will be used to create auto compensation samples and experiment samples.

#### Creating Compensation Control Samples

To create the auto compensation samples, click **Home > Compensation > Auto Compensation** to open the **New Auto Compensation** window. In the window, select the four parameters used in the experiment, **FITC (B525)**, **PerCP (B667)**, **APC (R667)** and **PE (Y586)**. The software will then create four single-stained samples to be used to calculate fluorescence compensation, and the software will automatically assign the samples to wells A3 to A6. The four created samples will be added to the **Compensation Specimen** node in the **Experiment Manager** panel as shown in Figure 17.

**NOTE**

For detailed information about the auto compensation, refer to associated Agilent flow cytometer operator’s guide.
Sample Acquisition

Creating Experiment Samples

New samples could be created through the Work List window or through the Plate Manager panel.

Create experiment samples through the Work List window

To open the Work List, click the Work List button from Home > Experiment > Work List. Alternatively, the Work List window can be opened by clicking the Work List button , from the Experiment Manager panel or Plate Manager panel.

After opening the Work List window:

1. Select Horizontal from the drop down menu of Well ID Setting Direction and click Automatic Setting Well ID button to enable automatic setting well ID function.

Figure 17. Creating Compensation Control Samples

Figure 18. Set Sample Well ID
Sample Acquisition

2. Right-click the header in the row for Specimen1 Sample1. Select Copy (Figure 19). Move the cursor to the last empty row below Specimen1 Sample1. Right-click the header and select Insert Copied Specimens (Figure 20). The software will create a new specimen, named as Specimen2, and the specimen will contain a sample, named Sample1, which will contain the Lymphocyte gate from Specimen1 Sample1.

![Figure 19. Copy Specimens and Samples](image)

3. Double-click the Specimen Name cell of the Specimen2 Sample1 row to modify the specimen name (Figure 21). Rename the specimen as Name1. Double-click the Stop Condition cell and set the stop condition to 5,000 events in the Lymphocyte gate.
Sample Acquisition

4. Click the header of the **Name1 Sample1** row to select the entire row. From the toolbar of the **Work List** window, click the **Duplicate as Sample** button (Figure 23). A new sample will be created within the **Name1** specimen and named **Sample2**. In the new sample **Name1 Sample2**, modify the alias under the **Y586** and **R667** parameters. Rename the alias for **Y586** as **CD16 + CD56 PE** and the alias for **R667** as **CD19 APC**.
Sample Acquisition

![Work List](image)

**Figure 23.** Duplicate Sample

5. Click the header of row to select both **Name1 Sample1** and **Name1 Sample2** rows (Figure 24). Click the **Duplicate as Specimen** button (Figure 24) from the toolbar 23 times to create the remaining 23 specimens and 46 samples. Rename each specimen as **Name2**, **Name3**, etc.

![Work List](image)

**Figure 24.** Duplicate Specimen

6. In the **Name1 Sample1** row, rename the **Well ID** to **B1**. The remaining sample wells will automatically update. The complete **Work List** is shown in Figure 25.
Sample Acquisition

Check the Work List to ensure the settings are correct and click the **Apply Modifications** button from the toolbar to save the changes made to the **Work List**. You will see the new samples automatically showing up in the **Experiment Manager** panel (Figure 26).
Create experiment samples from the Plate Manager panel

1. Open the Plate Manager panel by checking the View > Show > Plate Manager box if it is not visible.

2. Double-click well A2 to set sample Specimen1 Sample1 as the Active Sample (red background). Click well B1, input Name1 in the specimen name box input Sample1 in the sample name box and click the New Sample(s) on Selected Well(s) button in the Plate Manager panel toolbar to create a new sample with the same template as sample Specimen1 Sample1 in well B1.
Sample Acquisition

3 In the **Cytometer Setting** panel, change the event number stop condition to 5,000 events on gate **Lymphocyte**.

4 Set the **Samples Created Order** tool in the **Plate Manager** panel toolbar to **Horizontal**.

5 Click the **Duplicate Sample(s) on Selected Well(s)** button in the **Plate Manager** panel toolbar, rename the created sample as **Sample2**, modify alias of **Y586** as **CD16+56 PE** and modify alias of **R667** as **CD19 APC**.

6 While pressing **Ctrl** key, left click well B1 and B2 to select both wells, click the **Duplicate Sample(s) on Selected Well(s)** button in the **Plate Manager** panel toolbar 23 times to create the remaining 23 specimens and 46 samples. Sequentially rename each of the newly created specimens as **Name2, Name3**, etc. The created samples in the **Plate Manager** panel are shown in Figure 28.

![Figure 27. Plate Manager](https://example.com/image.png)
Sample Acquisition

Figure 28. Plate Manager Panel after Experiment Samples Created

7 Set the **Mixing** parameters as shown in Figure 13 as well.

The **Experiment Manager** panel will be updated with the newly created samples. The **Experiment Manager** panel is shown in Figure 29.
Sample Acquisition

In the **Experiment Manager** panel, a variety of templates can be used to easily perform fluorescence compensation and data analysis. Please refer to the [NovoExpress Software Guide](#).

If the sample acquisition conditions are different between samples, the **Work List** allows to modify individual collection conditions for individual samples.

For additional information regarding the **Work List**, refer to the [NovoExpress Software Guide](#).

**Plate View**

Plate view provides an intuitive view of the sample wells. To open the plate view, click the **Plate View** button from **Home > Experiment > Plate View**. In plate view, if the experiment contains multiple plates, the displayed plate can be switched using the **Plate** drop-down menu. The plate view is shown in Figure 30.

![Experiment Manager Panel after Experiment Samples Created](image)

**Figure 29.** Experiment Manager Panel after Experiment Samples Created
Sample Acquisition

Automatic Sample Acquisition

This section will describe the automatic sample acquisition procedure.

1. Remove the sample plate from the NovoSampler Q and load the plate according to the layout set for the experiment. In this experiment, the four single-stained samples for fluorescence compensation are in wells A3 to A6. The 48 samples from 24 different specimens are in wells B1 to E12. For each specimen, the first sample is stained with Agilent CD3 FITC/CD8 PE/CD45 PerCP/CD4 APC Reagent and the second sample is stained with Agilent CD3 FITC/CD16+CD56 PE/CD45 PerCP/CD19 APC Reagent. After preparing the sample plate, load the plate onto the sample tray of the NovoSampler Q and close the cover.

2. In the Cytometer Control panel, click the Run Plate button. The Select well(s) to run window will open as shown in Figure 31. In the window, select the wells to be collected. Wells selected for collection will be displayed in blue, unselected wells will be displayed in white, and wells that are not available for collection will be displayed in gray. In this experiment, select all of the wells.
Sample Acquisition

the samples from A3 to E12. Click the **Run** button to begin sample acquisition. The selected samples will be collected in the order listed in the **Work List**.

![Figure 31. Window for Selecting Wells to Run](image)

**NOTE**

Click the header row or header column to select all of the available wells in the row or column. Click the top-right corner cell of the grid to select all available wells on the plate.

3 The automatic Sample acquisition workflow with NovoSampler Q is shown in Figure 32. The process will begin with the sample tray moving to align the sample injection probe and the first sample well. NovoSampler Q will then mix the sample and it will be followed by sample acquisition. After sample acquisition is completed, the instrument will rinse the sample injection probe. The NovoSampler Q will then mix the sample, move the tray to align the sample injection probe with the next sample well and begin the sample acquisition. The process will continue until all the selected samples are acquired. The frequency of mixing and rinsing will depend on the settings in the **Plate Manager** panel, which is opened from **View > Show > Plate Manager**.
During automated sample acquisition, when started acquiring a new sample, a window shown in Figure 33 will be prompted. In the prompted window, user can determine if the new sample will become the Active Sample. Active Sample is the sample shown in the Workspace for data analysis and indicated by a red arrow on the left of a sample in the Experiment Manager panel. Click Yes to make the sample to be acquired as the Active Sample so that you can observe the data for each new sample when it is acquired. Click No to keep the sample currently in analysis as the Active Sample so that you can continue working on the data analysis, in the meanwhile the rest of the samples are been acquired. If there is no user interference within 10 seconds after this window appears, NovoExpress Software will automatically make the new sample to be acquired as the Active Sample. Check the Do not show this again in the current run checkbox and click Yes or No to make your selection as default for the rest of the plate run.
Sample Acquisition

To pause automated sample acquisition, click **Pause** button (Figure 34) in the **Experiment Control** panel. The **Pause** button then changes to a **Resume** button. The automated sample acquisition will be paused after current sample acquisition is completed. To stop current sample acquisition immediately, click **Stop Single Well** button in the **Experiment Control** panel. To resume automated sample acquisition, click **Resume** button. In this case, the **Select well(s) to run** window will not prompt. The software will automatically continue to run the rest wells in the experiment. To stop automated sample acquisition, click **Stop** button.
Read Plate Barcode

NovoSampler Q is equipped with a barcode scanner which can automatically read the barcode label attached to the microtiter plate. The barcode scanner is installed in the lower right corner of the NovoSampler Q (Figure 35) and protected by a metal cover. The scanning window faces the orbital shaker and projects scanning light emitted from the scanner onto the barcode on the microtiter plate to read the barcode.

![Figure 35. NovoSampler Q Barcode Scanner](image)

For correct barcode reading, the barcode should be attached to the center of right shorter side of the well plate (Side A in Figure 36) and is smaller than the dimension of side A. The minimum size of the barcode label is listed in Table 7.

![Figure 36. Center and Attach the Barcode Label to the Microtiter Plate](image)

NovoSampler Q barcode scanner is compatible with the barcodes as listed in Table 7.
### Sample Acquisition

#### Table 7  Compatible Barcode Labels for NovoSampler Q

<table>
<thead>
<tr>
<th>Code Type</th>
<th>Example</th>
<th>Minimum Size (W x L)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code 39 and Code 39 Extended</td>
<td><img src="image" alt="Code 39 Example" /></td>
<td>5.5 mm x 30 mm</td>
</tr>
<tr>
<td>Code 93</td>
<td><img src="image" alt="Code 93 Example" /></td>
<td>5.5 mm x 30 mm</td>
</tr>
<tr>
<td>Code 128, Code 128A, Code 128B and Code 128C</td>
<td><img src="image" alt="Code 128 Example" /></td>
<td>5.5 mm x 25 mm</td>
</tr>
<tr>
<td>EAN-8, EAN-13 and EAN-128 Code</td>
<td><img src="image" alt="EAN Example" /></td>
<td>5.5 mm x 25 mm</td>
</tr>
<tr>
<td>UPC-A and UPC-E Code</td>
<td><img src="image" alt="UPC Example" /></td>
<td>5.5 mm x 25 mm</td>
</tr>
</tbody>
</table>

---

**CAUTION**

Do not remove the metal cover of the barcode scanner. Dusts or potential sample spill on the scanner may interfere with the barcode scanning and may cause damage to the scanner.

---

**NOTE**

Ensure the scanning path is clear (i.e. there is no obstacle blocking the scanning window) in order to read the barcode correctly.

**NOTE**

User can print their own customized barcode labels using compatible barcode listed in Table 7 or order the compatible barcode labels from Agilent Technologies Inc. or use the commercially available microtiter plate with pre-labeled compatible barcode.
Sample Acquisition

NOTE

Ensure the barcode label attached to the plate have the proper size and is clearly readable.

To read the barcode information from the microtiter plate with a barcode label:

1. Ensure NovoSampler Q is properly installed and powered up.

2. Launch NovoExpress software. Click Setting > Option > Experiment and select the check box for Read plate barcode when running experiment (Figure 37) to enable the barcode reading function. Click OK. The barcode information field will be displayed under the Plate field in the Plate Manager panel as shown in Figure 38.

![Figure 37. Enable Reading Barcode Function in Experiment Setting Window](image)

---

**NOTE**

Ensure the barcode label attached to the plate have the proper size and is clearly readable.

To read the barcode information from the microtiter plate with a barcode label:

1. Ensure NovoSampler Q is properly installed and powered up.

2. Launch NovoExpress software. Click Setting > Option > Experiment and select the check box for Read plate barcode when running experiment (Figure 37) to enable the barcode reading function. Click OK. The barcode information field will be displayed under the Plate field in the Plate Manager panel as shown in Figure 38.

![Figure 37. Enable Reading Barcode Function in Experiment Setting Window](image)
Sample Acquisition

Figure 38. Plate Manager Panel when Barcode Reading Function is Enabled

3 Create the new experiment samples by following the instructions described in Creating Experiment Samples in this guide.

4 Ensure the sample plate is properly labeled with compatible barcode. Make sure there is sufficient sample in each well to be acquired.

5 Open the NovoSampler Q cover. Place the sample plate onto the orbital shaker with the correct orientation. There should be one barcode label facing to the right as shown in Figure 39.
Sample Acquisition

Figure 39. Load the Plate with Barcode onto NovoSampler Q

6 Close the NovoSampler Q cover. Click **Run Plate** or **Run Single Well** to start the sample acquisition. NovoSampler Q will move the plate to the barcode reading position and the barcode will be read automatically. The acquired barcode information will be automatically displayed in the barcode information field in the Plate Manager panel as shown in Figure 40.

Figure 40. Display the Barcode Information in Plate Manager
Sample Acquisition

NOTE

When the barcode reading function is enabled in the middle of an experiment (i.e. previously acquired samples do not have the barcode information), software will prompt a dialog box as shown in Figure 41. User can click Yes to apply the newly acquired barcode information to all the samples for the current plate, or click No to cancel applying barcode to any samples for the current plate, or click Cancel to cancel current sample acquisition.

![Figure 41. Prompted Dialog Box when Barcode Function is Enabled in the Middle of an Experiment](image)

NOTE

When user switches to a new plate in the same experiment (i.e. plate with different barcode is used), software will prompt user to replace the current plate barcode with the new one or create a new plate with the new barcode (Figure 42).

![Figure 42. Prompted Dialog Box When a Plate with New Barcode is Used](image)

NOTE

Under some situations when the scanner cannot properly read the barcode information, software will prompt a dialog window as shown in Figure 43. Ensure the barcode label is properly attached to the plate, the label is clearly readable, and the scanning window is not blocked. Click Retry to read the barcode information again or enter the plate barcode manually in this window. Contact Agilent technical support if this error occurs after retrying the barcode scanning for three times in a row.
Sample Acquisition

7 After the sample acquisition is completed, user can select to add the barcode information to the statistic table or the specimen or sample report.

- To add barcode information to the statistic table, click **Experiment > Statistical Table** from the NovoExpress main window, click the **Show Columns** button and select **Plate Barcode** in the pulldown menu (Figure 44).

- To add barcode information to the specimen and sample report, click the **Auto Report Mode** button in the **Report** window to disable the auto-report mode. Click **Plate Information** icon in the report window and
select the proper sample (Figure 45). The barcode information will be added to the report as part of the Plate Information.

**NOTE**

The barcode information can also be automatically added to the specimen or sample report. Click **Setting > Options > Report** from the software main window. Select **Plate Information** and Click **OK** (Figure 46). The plate information including the barcode information will automatically be displayed in the specimen and sample report after the sample acquisition is completed.

---

**Figure 45.** Manually Add Barcode Information to the Specimen or Sample Report
Sample Acquisition

Figure 46. Add Barcode Information to the Specimen or Sample Report in Auto Report Mode

Analysis of Data

After the sample is collected, data analysis can be performed with NovoExpress Software. NovoExpress software provides tools for batch data analysis of multiple samples generated with NovoSampler Q, such as analysis template, batch report, Statistical Table, etc. The data analysis process is summarized in Figure 47.

Figure 47. Data Analysis Procedure

NOTE

The Well ID and Plate ID information is included in the exported FCS files. Third party software could read this information for data analysis after importing the FCS files.

NOTE

For additional information regarding data analysis, please refer to NovoExpress Software Guide.
6 System Maintenance

This chapter describes the procedures to maintain NovoSampler Q.
It is important to conduct the instrument maintenance on a regular basis in order to achieve the optimal performance for the instrument and obtain reliable data.

Clean NovoSampler Q

The NovoSampler Q frequently comes into contact with the experimental sample. To prevent corrosion of the instrument, periodically clean the outer and inner surfaces of the NovoSampler Q.

1. Turn off instrument and unplug the power cable.

CAUTION
To prevent possible injury and damage to the NovoSampler Q, turn off the power of the Agilent flow cytometer and unplug the power cable before cleaning or moving the NovoSampler Q.

2. Prepare a damp soft cloth with NovoRinse solution. Wipe the top surface of the sample tray and accessible outer and inner surfaces of the NovoSampler Q.

3. Prepare a damp soft cloth with DI water. Wipe the surfaces again.

4. Wipe the surfaces one more time with a dry soft cloth.

WARNING
The NovoSampler Q and instrument may get contact with biohazardous material. During the cleaning procedure, use appropriate protective equipment, including gloves, clothing, and eyewear.

WARNING
Do not wipe the NovoSampler Q using isopropyl alcohol or ethanol.
Clean SIP with NovoSampler Q Connected

If the outer surface of the sample injection probe is dirty, follow the procedure below to manually clean the outer surface of the sample injection probe. It is recommended to clean SIP every month to ensure optimal instrument operating condition.

The procedures described below may vary if NovoSampler Q is not used. Please refer to Clean the Sample Injection Probe in associated Agilent flow cytometer operator’s guide for more details.

1. Click **Instrument > Shut Down** on the NovoExpress software.
2. Select **Clean sample injection probe** option and then click **Yes** button in the prompted window (Figure 48). NovoExpress software will guide you to conduct the cleaning SIP procedure.

   ![Figure 48](image-url)

   **Figure 48.** Message in NovoExpress Software when Shutting down

   The instrument will shut down directly if **Clean sample injection probe** option is not selected.

3. Follow the instruction in the software, remove the tube rack or sample plate. Click **OK** (Figure 49).
System Maintenance

Figure 49. Software Message When Starting the SIP Cleaning Procedure with NovoSampler Q Installed

**WARNING**
Sample injection probe will move downward after clicking the OK button. Do not put your fingers underneath the sample injection probe!

4 Prepare a cotton swab or a damp soft cloth with NovoClean solution (1X) and gently wipe the outer surface of the sample injection probe (Figure 50).

Figure 50. Wipe the Outer Surface of the Sample Injection Probe with NovoSampler Q Installed
System Maintenance

**WARNING**
Sample injection probe directly contacts the biological samples which may be biohazardous. Wear gloves when handling the sample injection probe.

**WARNING**
Sample injection probe is fragile and may be damaged if handled improperly. When cleaning the sample injection probe, please be careful not to deform or bend it.

5. Click **OK** button after cleaning. (Figure 51).

![Figure 51. Software Message Instructing the Cleaning Procedures](image)

6. Load a 40 tube rack on the orbital shaker and place a tube of Milli-Q or 0.2 µm filtered DI water or NovoRinse solution (1X) in A1 position. The instrument will shut down automatically after clicking **OK** button (Figure 52).
Figure 52. Software Message Instructing to Load a Sample Tube with NovoSampler Q Installed
System Maintenance

This page is intentionally left blank.
# Troubleshooting

This section describes errors and possible solutions related to the NovoSampler Q.

For technical support, please refer to Technical Support in this guide.

Table 8 provides guidance on troubleshooting the NovoSampler Q.

- For guidance on troubleshooting Agilent flow cytometer, refer to associated Agilent flow cytometer operator’s guide.
- For complete list of NovoExpress software prompted error or warning messages when operating Agilent flow cytometer and associated accessories, please refer to NovoExpress Software Guide.

Please contact Agilent Technical Support if issues are not resolved after performing the recommended solutions or if there are any issues which are not listed in these two tables.

Investigate possible causes and perform the recommended solutions in the given order.

<table>
<thead>
<tr>
<th>Observation</th>
<th>Possible Causes</th>
<th>Recommended Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample Injection Probe is not properly aligned with the wells</td>
<td>Plate or tube rack is not loaded correctly.</td>
<td>Load the plate or tube rack with the correct orientation. Make sure the plate or tube rack is seated onto the sample tray properly.</td>
</tr>
<tr>
<td></td>
<td>NovoSampler Q is not calibrated.</td>
<td>Click Instrument &gt; NovoSampler Q &gt; Calibrate in the NovoExpress Software to re-calibrate the NovoSampler Q.</td>
</tr>
<tr>
<td>Barcode scanner cannot properly read the barcode information</td>
<td>The <strong>Read plate barcode when running experiment</strong> function is not enabled.</td>
<td>Refer to Read Plate Barcode in this guide or NovoExpress Software Guide to enable the barcode reading function.</td>
</tr>
<tr>
<td></td>
<td>The barcode label attached to the plate is not compatible for NovoSampler Q.</td>
<td>Refer to Table 7 in this guide for list of compatible barcode labels for NovoSampler Q. Replace the labels on the plate accordingly.</td>
</tr>
</tbody>
</table>
## Troubleshooting

### Table 8  Troubleshooting Guide for NovoSampler Q

<table>
<thead>
<tr>
<th>Issue</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The barcode label attached to the plate does not have the proper size and is not clearly readable.</td>
<td>Refer to Read Plate Barcode in this guide for requirements of barcode labels for NovoSampler Q. Replace the labels on the plate accordingly.</td>
</tr>
<tr>
<td>The scanning path is blocked by some obstacles.</td>
<td>Locate and clear the obstacles.</td>
</tr>
<tr>
<td>The scanning window is dirty.</td>
<td>• Power off Agilent flow cytometer and NovoSampler Q.</td>
</tr>
<tr>
<td></td>
<td>• Gently push the shaker all the way to the left.</td>
</tr>
<tr>
<td></td>
<td>• Wipe clean the scanning window using clean soft cloth soaked with 70% ethanol.</td>
</tr>
</tbody>
</table>
8 Version History

Table 9 History of updates

<table>
<thead>
<tr>
<th>Date/Version</th>
<th>Changed by</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>08/30/2018</td>
<td></td>
<td>Initial Release.</td>
</tr>
</tbody>
</table>
Appendix A: NovoSampler Q Technical Specifications

This chapter lists technical specifications of NovoSampler Q.

Table 10  NovoSampler Q Technical Specifications

<table>
<thead>
<tr>
<th><strong>Physical Parameters</strong></th>
<th>Dimension (W x D x H)</th>
<th>16.9 × 11.0 × 11.8 in (43.0 × 28.0 × 30.0 cm)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Weight</td>
<td>29.3 lbs (13.3 kg)</td>
<td></td>
</tr>
<tr>
<td>Operating Temperature</td>
<td>15 °C ~ 32 °C</td>
<td></td>
</tr>
<tr>
<td>Operating Humidity</td>
<td>Relative Humidity: 80% maximum</td>
<td></td>
</tr>
<tr>
<td>Atmosphere Range</td>
<td>76-106 kPa</td>
<td></td>
</tr>
<tr>
<td><strong>Installation</strong></td>
<td>Installation Method &amp; Calibration</td>
<td>Automated self-calibration after installation. No need to reconfigure fluidics tubing or connection.</td>
</tr>
<tr>
<td><strong>Performance and Capability</strong></td>
<td>Labware Compatibility</td>
<td>Agilent Flow Cytometer 40 tube rack for 12 × 75 mm tube, 24-well, 48-well, 96-well (flat, U-, V-bottom), 384-well microtiter plate, Agilent Flow Cytometer 24 tube cooling rack for 12 × 75 mm tube, Agilent Flow Cytometer 96-well plate cooling box.</td>
</tr>
<tr>
<td>Labware Calibration</td>
<td>Automated bottom height mapping and calibration to accommodate different labware. Calibrated labware template can be saved for future use</td>
<td></td>
</tr>
<tr>
<td>SIP Collision Detection</td>
<td>Automated fluidics system recovery after detection of SIP collision; automatic acquisition of the next sample after successful recovery</td>
<td></td>
</tr>
<tr>
<td>Carryover</td>
<td>&lt; 0.1%</td>
<td></td>
</tr>
<tr>
<td>Mix Mode</td>
<td>Orbital shaking up to 3000 rpm. User definable mixing frequency, speed, acceleration and duration</td>
<td></td>
</tr>
<tr>
<td>Barcode Reading</td>
<td>Integrated barcode reader. Automatically prompt barcode as plate name in the software</td>
<td></td>
</tr>
<tr>
<td>Fluidics System Rinse</td>
<td>Automated post-sampling rinse for every sample. User definable extra rinse cycle and rinse frequency</td>
<td></td>
</tr>
</tbody>
</table>
In This Guide

This guide describes the following:

- Prologue
- Introduction
- Installation
- Instrument Operation
- Sample Acquisition
- System Maintenance
- Troubleshooting
- Version History
- Appendix A: NovoSampler Q
  Technical Specifications